Diann Kufel

From: ~ Anthony Burkinshaw
Sent: Wednesday, May 25, 2022 1:26 PM
To: Dianne Kufel
Subject: . RE:2022 Summer Lifeguard Staff
021§ Location Position Pay Rate
Kennedy Lifeguard S 13.50
Kennedy Lifeguard $ 13.50
Kennedy Lifeguard § 13.50
Kennedy : Lifeguard $ 13.50
Kennedy - WS/ Lifeguard S 14.67
Kennedy Aquatics Facility Manager $ 17.32
Kennedy - Lifeguard § 1350
e/ Dahr ' Kennedy Head guard $ 15.84
Ashley Kon ' Kennedy Lifeguard . $ 13.20

Tony Burkinshaw

Village of North Syracuse
Parks & Recreation Director
(315)458-8050

= HORTH







Dianne Kufel

Froxm: Anthony Burkinshaw

Sent: Monday, May 23, 2022 12:24 PM
To: Dianne Kufel

Ce: Diane Ilacqua; Donald Radell
Subject: 2022 Summer Playground Staff
2022 Summer Playground Staff . Location
Breanna Burrows Heritage
Megan Stanton Heritage
Gianna Sato Heritage
Olivia Kozlowski Heritage
Ma tthew Morgese Heritage
Noabh Slifka Heritage
5/12/22

Sierra Coleman Lonergan
SofiaZiankoski . Lonergan
Maxwel] Steffon Lonergan
Adrina Henderson Lonergan
Maria Sanfilippo Lonergan
Lily Misco Lonergan
Arinna VanDusen Lonergan
Luke Springett Lonergan
Alexandra Dietrich Lonergan
Summer Staff:

Dawn Lonkey Parks

Tony Burkinshaw

Viliage of North Syracuse
Parks & Recreation Director

Position Pay Rate
Recreation Leader $15.00
Rec, Aide $13.20

Rec. Aide $13.25
Rec. Aide $13.25
Rec. Aide $13.31
Rec. Aide APPROVED
Recreation Leader $15.00
Rec. Aide $13.20
Rec. Alde ‘ $13.20
Rec. Alde $13.20
Rec, Aide $13.,20
Rec. Aide $13.20
Rec. Aide $13.20
Rec, Aide $13.20
Rec. Aide $13.20
PT Seasonal $14.75
o 1. SYRAGUSE
u\\.\g‘\%\(ﬂ“e"s\m







Steel Sales, Ine.

RT.12, SHERBURNE, NY 134860
Distributors & Fabricators

‘ FAX TOLL FREE NYS
607-674-6363 { 0607-674-9706 i 800-208-7833

2o Elpn. Pelicas, suoontr. -
o L #3$a

ODB. LeTeoc z doad collrlor
| ﬂz, 125,00

Toe  [Frounds master
ﬁ({ 600,00

ﬂ/// 2 7{&0

“Distr‘ibutor of HardoxTM Abrasion Resistant Plate, ”
American Building Components™ Siding and Roofing Products.
ESCO™ Plow Blades & Cutting Edges.

www.SteelSaleslnc.com
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Extreme Winter Recovery Apportionment Balances 15@ , L,L/H Q 7

Total Available for Lo Total Available
DOT | Muni Name State Fiscal Year (SFY) 2022-23 After
; : Mar 31, 2022
code ) ) Rollover Apportionment Total Pavinent
Balance SFY 202223 w
330170 Town of Clay 0.00 73,314.54 73,314.54 73,314.54
33023 3| Town of Dewitt 0.00 71,144.30 71,144.30 71,144,30
330259 Town of Elbridge ‘ 0.00 19,975.67 19,975.67 ‘ 19,975.67
330279 Town of Fabius 0.00 21,597.71 21,597.71 21,597.71
33031 7| Town of Geddes 0.00 28,881.52 28,881.52 28,881.52
330445 Town of Lafayette 0.00 18,261.55 18,261.55 | 18,261.55
330493 Town of Lysander 0.00 33,840.78 | . 33,840.78 33,840.78
© 330506| Town of Manliug ‘ 0.00 49,763.66 49,763.66 - 49,763.66
33051 0| Town of Marcellus 0.00 13,049.65 13,049.65 13,049.65
33061 1| Town of Onondaga 0.00 48,660.50 48,660.50 48,660.50
330626 Town of Otisco 0.00 24,266.44 24,266.44 24,266.44
330679 | Town of Pompey : - 0.00 35,083.60 35,083.60 35,083.60
330739 Town of Salina 0.00 60,812.55 60,812.55 60,812.55
33077 8| Town of Skaneateles 0.00| ~ 25,889.54 25,889.54 25,889.54
330793 | Town of Spafford 0.00 15,599.63 15,599.63 15,599.63
33083 6| Town of Qully ' 0.00 13,457.64 13,457.64 13,457.64
330849 | Town of Van Buren 0.00 26,065.81 26,065.81 26,065.81
331033 Village of Baldwinsville 0.00 25,766.61 25,766.61 25,766.61
331068 | Village of Camillus ' 0.00 6,769.62 6,769.62 6,769.62
331147| Village of East Syracuse 25,537.09 21,156.77 46,693.86 46,693.36
331151 Village of Elbridge 5,893.81 5,908.64 11,802.45 11,802.45
331161 Village of Fabius : 2,867.12 1,737.65 4,604.77 4,604.77
331167 | Village of Fayetteville 43,699.82 38,672.41 82,372,23 82,372.23
331249 | Village of Jordan 10,331.38 1 9,142.81 19,474,19 19,474.19
331275 Village of Liverpool 11,724.28 15,293.63 27,017.91 27,017.91
331291 Village of Manlius 0.00 22,486.42 22,486.42 22,486.42
331295 Village of Marcellus 28,154,22 6,256.49 34,410.71 34,410.71
331316 Village of Minoa 0.00 9,686.80 9,686.80 9,686.80
- 331352 | Village of North Syracuse - 0.00 . 29,166.59 129,166.59 29,166.59
331463 | Village of Skaneateles 0.00 9,595.78 ©9,595.78 © 9,595.78
331468 | Village of Solvay 0.00 33,080.76 33,080.76 33,080.76
331493 | Village of Tully ‘ . 0.00 2,780.66 2,780.66 | 2,780.66
332055 | City of Syracuse : 0.00 587,489.21 587,489.21 587,489.21
340000 | County of Oswego 0.00 723,995.24 723,995.24 723,995.24
340006 | Town of Albion 59,405.23 36,003.17 95,408.40 95,408.40
340017 | Town of Amboy 0.00 22,560.69 22,560.69 22,560.69
340085 | Town of Boylston . 0.00 15,260.68 15,260.68 15,260.68
340198 | Town of Constantia 2,584.80 41,242.27 43,827.07 43,827.07
340336 | Town of Granby 0.00] - 39,574,772 39,574.72 - 39,574,772
340369 | Town of Hannibal 0.00 38,849.73 38,849.73 38,849.73
340382 | Town of Hastings 3,593.00 36,209.78 ' 39,802.78 _ 39,802.78
340525 | Town of Mexico 0.00 46,557.22 46,557.22 46,557.22
340538 Town of Minetto 0.00 5,609.97 5,609.97 5,609.97
340575 | Town of New Haven 0.00 25,242.49 25,242.49 25,242.49
340619 | Town of Orwell ' 0.00 27,086.33 27,086.33 27,086.33
340624 | Town of Oswego 0.01 27,374.54 27,374.55 27,374.55
340636 | Town of Palermo 0.00 27,164.79 27,164.79 27,164.79
34064% Town of Parish 0.00 32,309.74 32,309.74 32,309.74

To Search by DOT Code, Click on the Search fcon (binocular) or click Edit->Find menu option
To Print, click on File->Print menu option. Choose "Current Page" for printing 1 page only




PAVENY Balances

Total Available

Total Available for
DOT Muni Name State Fiscal Year (SFY) 2022-23 After
- : Mar 31, 2022
code Rollover Apportionment Total p ¢
Balance SFY 2022-23 aymen
330170 | Town of Clay 0.00 91,043.78 91,043.78 91,043.78
330233 | Town of Dewitt 0.00 84,115,55 84,115.55 84,115.55
330259 | Town of Elbridge 0.00 23,138.13 23,138.13 23,138.13
330279 | Town of Fabius - 0.00 24,819.86 24,819.86 24,819.86
330317 | Town of Geddes 0.00 34,495.75 34,495.75 34,495.75
330445 | Town of Lafayette 0.00 21,336.84 21,336.84 21,336.84
330493 | Town of Lysander 0.00 44,422.61 44,422.61 44,422.61
330506 | Town of Manlius 0.00 60,953.69 60,953.69 60,953.69
330510 | Town of Marcellus 0.00 15,361.68 15,361.68 15,361.68
330611 | Town of Onondaga 0.00 59,065.53 59,065.53 59,065.53
330626 | Town of Otisco 0.00 27,930.93 27,930.93 27,930.93
330679 | Town of Pompey 0.00 43,261.75 43,261.75 43,261.75
330739 | Town of Salina 0.00 71,303,76 71,303.76 | 71,303,76
330778 | Town of Skaneateles 0.00 30,656.06 30,656.06 30,656.06
330793 | Town of Spafford 0.00 17,971.80 17,971.80 17,971.80
330836 | Town of Tully 0,00 15,707.16 15,707.16 15,707.16
330849 | Town of Van Buren 0.00 30,781.05 30,781.05 30,781.05
331033 | Village of Baldwinsville 0.00 33,941.02 33,941.02 33,941,02
331068 | Village of Camillus 0.00 8,540.05 8,540.05 8,540.05
331147 | Village of East Syracuse 54,869.40 25,273.22 80,142.62 80,142.62
331151 | Village of Elbridge 15,119.10 " 17,636.15 22,755.25 22,755.25
331161 | Village of Fabius 3,519.47 2,110.64 5,630.11 5,630.11
331167 | Village of Fayetteville 0.00 44,933.81 44,933.81 44,933.81
331249 | Village of Jordan 12,823.73 11,309.20 |- 24,132,93 24,132.93
331275 | Village of Liverpool 11,990.29 18,719.47 30,709.76 30,709.76
331291 | Village of Manlius 0.00 28,043.05 28,043.05 28,043.05
331295 | Village of Marcellus 14,072.18 7,669.42 21,741.60 21,741.60
331316 | Village of Minoa 0.00 13,268.27 | 13,268.27 13,268.27
1331352 | Village of North Syracuse - "0.00 i 36,147.22 " 36,147.22 36,147.22 | -
. 331463 | Village of Skaneateles 0.00 12,191.23 12,191.23 12,191.23
331468 | Village of Solvay 0.00 40,847.20 40,847.20 40,847.20
331493 | Village of Tully 0.00 3,482.71 3,482.71 3,482.71
332055 | City of Syracuse 0.00 936,542.96 936,542.96 936,542.96
340000 | County of Oswego . 0.00 1,108,619.37 1,108,619.37 1,108,619.37
340006 | Town of Albion 0.00 43,285.04 43,285.04 43,285.04
340017 { Town of Amboy 0.00 28,377.08 28,377.08 28,377.08
340085 | Town of Boylston 0.00 19,850.55 19,850.55 19,850.55
340198 | Town of Constantia 0.00 48,362.80 48,362.80 48,362.80
340336 | Town of Granby 0.00 47,687.97 47,687.97 47,687.97
340369 | Town of Hannibal 0.00 46,130.88 46,130.88 46,130.88
340382 | Town of Hastings 121.50 43,333.55 43,455.05 43,455.05
340525 | Town of Mexico 0.00 55,073.84 55,073.84 55,073.84
340538 | Town of Minetto 0.00 6,572.75 6,572.75 6,572.75
340575 | Town of New Haven 0.00 29,983.09 29,983.09 29,983.09
340619 | Town of Orwell 0.00 32,046.45 32,046.45 32,046.45
340624 | Town of Oswego 0.00 33,371.28 33,371.28 33,371.28
340636 | Town of Palermo 0.00 33,057.20 33,057.20 33,057.20
Town of Parish 0.00 38,147.94 38,147.94 38,147.94

340640

To Search by DOT Code, Click on the Search icon (binocular) or click Edit->Find menu option

To Print, click on File->Print menu option. Choose "Current Page" for printing 1 page only




CHIPS Capital Apportionment Balances

Total Available for Total Available
DOT Muni Name State Fiscal Year (SFY) 2022-23 After
, : Mar 31, 2022
code Rollovm Apportionment Total Pavment
Balance SFY 2022-23 Y
330170|Town of Clay 0.00 339,221.26 339,221.26 339,221.26
33023 3{ Town of Dewitt 0.00 316,816.09 316,816.09 316,816.09
" 330259|Town of Elbridge 20,793.71 87,553.98 108,347.69 108,347.69
330279 Town of Fabius 0.00 94,087.76 94,087.76 94,087.76
33031 7| Town of Geddes 32,375.55 129,631.42 162,006,97 162,006,97
33044 5| Town of Lafayette 0.00 80,578.92 80,578.92 80,578.92
330493 | Town of Lysander 0.00 163,583.53 163,583.53 163,583.53
330506 Town of Manlius 0.00 227,787.84 227,787.84 227,787.84
33051 0| Town of Marcellus 0.00 57,915.69 57,915.69 57,915.69
33061 1| Town of Onondaga 0.00 221,170.04 221,170.04 221,170.04
330626) Town of Otisco 0.00 105,842.83 105,842.83 105,842.83
330679 Town of Pompey 10,805.44 161,435.88 172,241.32 172,241.32
330739 | Town of Salina 0.00 269,065.63 269,065.63 269,065.63
33077 8| Town of Skaneateles 61,181.17 .115,425.05 176,606.22 176,606.22
330793 | Town of Spafford 0.00 68,088.90 68,088.90 68,088.90
330836 Town of Tully 0.00 59,332.70 59,332.70 59,332.70
330849 [ Town of Van Buren 0.00 115,966.39 115,966.39 115,966.39
331033 | Village of Baldwinsville 0.00 124,896.35 124,896.35 124,896.35
331068 | Village of Camillus 0.00 31,712.08 31,712.08 31,712.08
331147 Village of East Syracuse 26,084.19 94,970.92 121,055.11 121,055.11
331151 Village of Elbridge 44,303.86 28,211.14 72,515.00 72,515.00
331161 Village of Fabius 14,072.71 7,902,07 21,974.78 21,974.78
331167 | Village of Fayetteville 0.00 169,908.20 169,908.20 169,908.20
331249 | Village of Jordan '48,799,71 42,173.00 90,972.71 90,972.71
331275 Village of Liverpool 0.00 69,966.58 69,966.58 69,966.58
331291 | Village of Manlius 0.00 104,390.26 104,390.26 104,390.26
331295 | Village of Marceltus 30,185.95 28,656.17 " 58,842.12 58,842,12
331316 | Village of Minoa 2.00 48,438.72 48,440.72 48,440.72
33 1352 | Village of North Syracuse .32,320.15 134,739.86 167,060.01 .167,060.01
331463 | Village of Skaneateles 0.00 45,202.06 45,202.06 45,202.06
331468 | Village of Solvay 0.00 152,380.99 152,380.99 152,380.99
331493 | Village of Tully 0.00 12,952.42 12,952.42 12,952.42
332055 | City of Syracuse 3,159,229.38 3,322,800.29 6,482,029.67 6,482,029.67
340000 | County of Oswego 2,672,858.79 3,961,880.70 6,634,739.49 6,634,739.49
340006 | Town of Albion 0.00 162,423.47 162,423.47 162,423.47
340017 | Town of Amboy 0.00 105,440.12 105,440.12 105,440.12
340085 | Town of Boylston 11,444.16 73,237.12 84,681.28 84,681.28
340198 [ Town of Constantia 0.00 182,492.92 182,492.92 182,492.92
340336 | Town of Granby 0.00 178,854.42 178,854.42 178,854.42
340369 | Town of Hannibal 21,722.23 |. 173,581.73 195,303.96 | 195,303.96
340382 | Town of Hastings 67,634.53 162,771.76 230,406.29 230,406.29
340525 | Town of Mexico 0.00 207,408.45 207,408.45 207,408.45
340538 Town of Minetto 0.00 24,806.65 24,8006.65 24,806.65
340575 | Town of New Haven 0.00 112,812.51 112,812.51 112,812.51
340619 | Town of Orwell 0.00 120,682.69 120,682.69 120,682.69
340624 | Town of Oswego 0.00 124,840.26 124,840.26 124,840.26
340636 | Town of Palermo 0.00 123,713.18 123,713.18 123,713.18
34064@ Town of Parish 199,420.27 143,726.38 343,146.65 343,146.65

To Search by DOT Code, Click on the Search Icon (binocular) or click Edit->Find menu option

To Print, click on File->Print menu option. Choose "Current Page” for printing 1 page only




NEW YOR-K STATE DEPARTMENT OF TRANSPORTATION
Pave Our Potholes (POP) Program Fact Sheet

Background
A new state funding Initiative enacted in the SFY 2022-23 Budget apportions $100 million annually to
assist municipalities with the rehabllitation and reconstruction of local highways and roads.

7

Eligible Applicants
Pave Our Potholes (POP) is available to all cities, counties, towns and villages that report local roadway

- mileageto NYSDOT pursuant to the Local Highway Inventory (LH1).

Funding Avalilability \
The new five-year State Transportation Plan authorizes $100 million annually for the next five years.

‘ Subject to appropriation, eligible activitles will be reimbursed as of April 1 of eachrespective year.

Apportionment of Funds _
Funds are apportioned by NYSDOT based on the ratio of funds each municipality received under

Consolidated Local Street and Highway Improvement Program (CHIPS), as is done with the PAVE-NY
program.

Eligible Projects

Eligible project activities Include highway resurfacing and highway reconstructlon projects with a service
life of ten years or more. Municipal project sponsors must follow locally adopted street and highway
design and construction standards. The Amerlcan Assoclation of State Highway and Transportation
Officlals (AASHTO) standards for local streets and highways or NYSDOT highway standards may be used

for the design of municipally owned roads.

Programmatic Requirements A
POP will follow the programmatic and reimbursement requirements of PAVE-NY, with eligible project
actlvities limited to Highway Resurfacing and Highway Reconstruction. Refer to the NYSDOT Program

Guidelines for additional information.

Relmbursements
Municipalities should use the PAVE-NY CP75 form to request reimbursement under this program.

Relmbursements in SFY 2022-23 will be made on or about 15th of July, September, December, and March.
Requests for reimbursements must be submitted within 18 months of a project’s completion for

expenditures incurred on or after April 1,2022.

Carryover Balances :
Subject to reappropriation, POP apportionments will be eligible for carryoverfrom one SFY to the next.

Notwlithstanding, municlpalities are strongly encouraged to utilize funds in the year apportioned to
Improve the physical condition of roadways, create Jobs and enhance local economic competitiveness.

For additional Information contact your CHIPS representative, Alisting of Regional CHIPS representatives
can be found at; hitps://www.dot.ny.gov/programs/chips/representatives. '




Onondaga

Onondaga .

Onondaga
Ononhdaga
Onondaga

Onondaga
Onondaga
Onondaga
Onondaga
Ontarlo
Ontario
Ontario
Ontario
Ontario
Ontarlo
Ontarlo
Ontario
Ontarlo
Ontarlo
Ontario
Ontarlo
Ontarlo
Ontarlo
Ontarlo
Ontarlo
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Ontario
Orange
Orange
Orange
Orange
Orange
Orange
Orange

310477804630

310425902490
310473902750
310450602910
310451002950
310450603160

310431704680
310483604930

320100000000

320208000000
320215000000

320309300000
320311900000
320312100000
320324600000
320328300000
320332100000
320333200000
320340000000
320350400000
320355500000
320365800000
320371100000
320376400000
320378800000
320385700000
320388900000

320424600465
320450401030
320450402900
320455903320
320465803870
320450404580
320485705060

330100000000
330230000000
330232000000
330245000000

330307800000

Village of Jordan
Viilage of Liverpool
Village of Manlius
Village of Marcelius
Village of Minoa

VillageiofiNorth:Syracuse -

Village of Skaneateles
Village of Solvay
Village of Tully

Village Sub Total
County of Ontarfo
County Sub Total

City of Canandaigua
City of Geneva

City Sub Total

Town of Bristol

Town of Canadice
Town of Canandalgua
Town of East Bloomfield
Town of Farmington
Town of Geneva
Town of Gorham
Town of Hopewell
Town of Manchester
Town of Naples

Town of Phelps

Town of Richmond
Town of Seheca
Town of South Bristol
Town of Victor

Town of West Bloomfield
Town Sub Total
Village of Bloomfield
Village of Clifton Springs
Village of Manchester
Village of Naples
Village of Phelps
Village of Shortsville
Village of Victor
Village Sub Total
County of Orange
County Sub Total

City of Middletown
City of Newburgh
City of Port Jervis

City Sub Total

Town of Blooming Grove

7,539.47
12,479.64
18,695.37

5,112.95

8,845.51

€ 24,098.15

8,127.49

- 27,231.46
2,321.81
196,075.11
394,642.03
394,642.03
48,672.45
62,861.89
111,534.34
26,086.32
21,072.97
47,939.05
23,786.31
41,941,92
13,179.06
37,918.49
21,569.68
30,634.62
23,816.14
51,841.38
28,065.42
42,484.12
18,409.16
35,145.41
15,059.92
478,949,97

5,907.97
10,871.28

6,550.22

9,521.98
11,490.60

6,338.14

8,609.70
59,289.89

598,188.68
598,188.68
114,019.21
83,601.02
53,452.45
251,072.68
25,654.57




STATE OF Governor

NEW YORK Depa_rtmentof | ~ KATHYHOCHUL
rroRiNTe 1 Transportation

MARIE THERESE DOMiNGUEZ
Commissioner

| RECEIVED
Meyin2022 | MAY 16 2022
ED WARE | - )
HIGHWAY SUPERINTENDENT o - Villags of North Syracust
VILLAGE OF NORTH SYRACUSE |
600 SOUTH BAY RD

NORTH SYRACUSE NY 13212

Dear Mr. Ware:

The enacted State fiscal year (SFY) 2022-23 Budget provides $100 million to counties, cities,
towns, and villages for a new Pave Our Potholes (POP) Program to resurface and renew the
worst roadway pavements in the State. The New York State Department of Transportation
(NYSDOT) will make the first SFY 2022-23 reimbursement on July 28, 2022. Eligible expenses
for the July payment will be reimbursed for expenditures on or after April 1, 2022. Additional POP
Program information on apportionments, program guidelines, project eligibility, and the CP75

reimbursement request form are available at: https:/www.dot.ny.gov/programs/chips.

The Village of North Syracuse has a SFY 2022-23 POP apportionment of $24,098.15. POP
reimbursement requests require the same supporting documentation as the CHIPS, EWR, and
PAVE-NY Programs. To ensure timely reimbursement, submit requests for each project to the
NYSDOT Regional Office listed below no later than June 23, 2022. Municipalities may e-mail

_their POP reimbursement request forms and supporting documentation for each project to the
regional mailbox address listed below. :

Maranda Roth :
NYSDOT Regional CHIPS Representative
New York State Department of Transportation
333 East Washington Street .
Syracuse, NY 13202
dot.sm.r03.CHIPS@dot.ny.gov

If you have any questions, please contact Maranda Roth at 315-428-4565.

Respectfully yours,

nun Qs

Dawn Arnold
Acting Director, Local Programs Bureau

50 Wolf Road, Albany, NY 12232 | www.dot.ny.gov



BUDGET TRANSFERS

BOARD APPROVAL NOT NECESSARY
USE BETWEEN THE SAME OBJECT ACCOUNTS

From Account Number:

To Account Number; _
[ﬂnount: $
Reason:
MACEE
BUDGET ADJUSTMENTS
BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS
From Account Number: ,4 5](0 Hi =2 EQL,UP/)?[,() T /%[A/TA?L
To Account Nuxﬁber: A 8 K0, Y LO TREE R = /V)O\//} L

Amount: $3 %0 .59

Reason: 70 PuUROUASE PLANTERS TOR mas/N STAEET WHERE

DEAL TREES WeRs AEmovE. 1E W)E ORMNER THESE ASAP
WE _OAN GET A blay SHiP ;M—'/z:,../fg THE PLANTERS ARE
ON_DRME TO NEW LRO CONTAINEAS,

FROM | TO
Account # ) Account #
(45110 443) ' (A¥560.446 )
Present Account Balance: 5 L0935 %8 5.430%l -5‘(?>‘
Change: $<30“6(e 59y s_3086 .59
New Account Balance: $ -0 .=

Signature of Department Head 4‘ ; Z ,—4/ A?/ L

(To approve the Transfer)

Date: 5/070 ,[&00?9?




DEPT. USE ONLY. " VILLAGE OF NORTH SYRACUSE BATE STAVP
- / 2‘( e (} REQUISITION FORM
; 2 o
o FY aoa:/ao;z&
Account Amount = -
Requesting Dept AAPL() '48 ” —F e
560 446 | Q00657
Vendor: Name: NI:LO PRO CQQ’(’A’IU}?AS S ) D07, - w.? o -
Address: INSURANCE a
HOLD HARMLESS 4

BN MR - DESCRIPTION CE | TOTALC
WANNSEE Boub FIAERGLASS PLANTEL 163,37 TL32.70
Hp x B9" H  maTTE TERMPCOTTA,
J / béL
W tre LRAINASE HOLES %, @P\W , .
CALIGHT ~'S02THE 1378.87
Ll Est, st JATE ulaffaz 1F we ORkEE. T//é«%; '
Budget Tl‘ahsferAttachedEYES' QaNo Approved by: ORDER TOTALAS 20606.591.
Authorized By: )\pu) EFw. Mayor : Date:
Date: 5 AQO/&OQ L Trustee Date:
7 1 (Gver 985] '
Trustee Date:
[Over 998 . R
Public Works Contracts Egg:_hgsl_n_g_m_rm_m

$0.00 to $3,000 No quotes necessary
$3,001 to $10,000 Written RFP and Two (2) Proposals
$10,001 to $35,000 Written RFP and Three (3) Proposals
$35,001+ Bid Pursuant to GML, Section 103

$0.00 to $1,000 No quotes necessary
$1,001 to $3,000 Two (2) verbal quotations

$3,001 to $10,000 Three (3) written quotations / proposals
$10,001 + Bid and/or State or Gounty Contract




NewPro

NewPro Contalners
16460 Southpark Dr.
Westlisld IN 46074
United States
(317)733-8499

BillTo

North Syracuse DPW
600 South Bay Road
Syracuse NY 13212
United States

" CONTAINERS

ShipTo

North Syracuse DPW
106 Fergerson Ave
Syracuse NY 13212
Unlted States

Sales Order

Date
Order #

Payment Method
Terms

PO#

Shipping Method
Estimated Ship Date
Tracking #

Allow Cross-Subsidia...

5/19/2022
50287460

Freight
6/24/2022

No

Terracotta

1 RO 0
80287460

b

Shipping Cost (Fre.:_ght)

Subtotal

otal

7,832.70
1,373.89
$9,006.59







Dianne Kufel

From; Franco, Amy <AFranco@chacompanies.com>

Sent: Monday, May 23, 2022 4:51 PM

To: Dianne Kufel

Ce: _ Gary Butterfield \
Subject: [External] RE: [--EXTERNAL--]: Comm, Dev, 2022 for 2023

Talked to Mike and he was just confused about why we submitted the same application 2 years'ii @ row when we had
received the money for the project and wasn’t sure if we should be submitting for something else..He confirmed with
Marty that the switch was OK and just needed a blurb on the flooring project (sent to himin t &’other email). Basedhan
his email it now appears that we need to do an updated 5 Yr Plan to include the flooring Rroject.’If it can be on the 5/2
meeting, great... otherwise we can put it on the next agenda since it doesn’t seem to be tod-time sensitive.

Ry

So, no to doing another application for $150k. ' RN

Amy Franco, RLA*
Landscape Architect IV
CHA
Office: (315) 257-7236
Mobile: (315) 440-0585
afranco @chacompanies.com
www.chacompanies.com

- *NY

CELEBRATING

G

From: Dianne Kufel <dkufel@northsyracuseny.org>
Sent: Thursday, May 19, 2022 11:01 AM

To: Franco, Amy <AFranco@chacompanies.com>

Cc: Gary Butterfield <gbutterfield@northsyracuseny.org>
Subject: [--EXTERNAL--]: Comm. Dev, 2022 for 2023
Importance: High

Mayor was talking to Mike LaFlare.....is there a way to submit an application for the $150,000....'.he acts like we still
can? Mavyor is interested in Gazebo, pervious pavement......green initiative.....can we do?

Best,







Hold Harmless Agreement

Town of Clay Fire Training Facility Usage Agreement 2022

Brewerton, Caughdenoy, Clay, Moyers Corners, North Syracuse Fire Departments along
with Take the Door identified below as
THE CLAY TRAINING TOWER COMMITTEE or THE TOWER COMMITTEE.

We the . , here after known as THE USER, wish to use the
facility owned and/ or maintained by THE CLAY FIRE DEPARTMENT, INC for the
purpose of training our members. THE USER understands that they will be charged a fee
for this use, and that, in consideration for allowing them to use the facility, The Clay Fire
Department, Inc., expects that THE USER will be legally responsible for all that may
occurrelative to THE USERS activities. Further that THE USER will hold the CLAY
FIRE DEPARTMENT Inc. and any authorized representatives, which may include The
Clay Training Tower Committee and/or “Tower Committee” harmless for all claims of
any type that might arise.- :

Specifically, THE USER understands and must provide:

e THE USER will provide a certificate of insurance with the CLAY FIRE
DEPARTMENT Inc. 4383 Route 31 Clay, NY 13041 and any authorized
representatives as additional insured.

e THE USER will provide on an ACORD 25 Jorm proof of insurance both
Workers Compensation, (VFBL), and General Liability, coverage each
occurrence with a minimum of $1,000,000 and $3,000,000 aggregate.

¢ CLAY FIRE DEPARTMENT Inc. and any authorized representatives will
provide facilitator(s) only, as needed for the facility’s safe operation.

® Operators will only be provided for use of propane props.

® The Users and their members shall be responsible for Class “A “fires
operations.




THE USER will provide supervision for and be responsible for all their activities, 7THE
USER certifies that all activities will be in full compliance with NFPA 1403, NFPA 1500
and any local, state, federal law or regulation.

THE USER will be responsible to utilize this facility in a manner which is
consistent with standard training practices. THE USER will not cause damages in excess
of normal wear and tear associated with such training practices.

THE USER will be responsible for removing all debris and garbage associated
with the User’s time at the facility. The USER agrees to pay a PENALTY FEE of $300 to
the “Clay Fire Department Inc” for failure to do so within 30 days of the said usage.

THE USER will forfeit future use of the facility if repeated offense(s) to the above
statute are noted.

THE USER cannot rely upon the CLAY FIRE DEPARTMENT Inc. and any
authorized representatives _for assurances expressed or implied that THE USERS activities
will not cause harm to members of THE USERS department or others.

By allowing THE USER to utilize the facility, CLAY FIRE DEPARTMENT Inc.
and any authorized representatives is also making no assurance whatsoever that no harm
will come to THE USERS members or guests either by THE USERS activities, or by the
facility itself.

THE USER is fully responsible to ensure that the facility is adequate to engage in
their activities safely, and it is THE USER’S responsibility to refrain from these activities
when they deem they are not. ‘

THE USER understands the activity that they will engage in and the risks
associated with these activities and that CLAY FIRE DEPARTMENT Inc. and any
authorized representatives, provides THE USER with no information in this regard.

CLAY FIRE DEPARTMENT Inc. and any authorized representatives may
provide at THE USERS request the class room facilities (at an additional charge) to be
covered under this agreement.

The USER will sign documentation that their members or guests are both
physically able and trained to perform these activities.

THE USER agrees to be legally responsible and defend, indemnify, and hold
CLAY FIRE DEPARTMENT Inc. and any authorized representatives harmless from any
harm that may come to THE USERS members or guests as a result, direct or indirect, as a
result of the facilities, but in consideration or the use of the facility,



THE USER further agrees to defend, indemnify, and hold harmless the CLAY
FIRE DEPARTMENT Inc. and any authorized representatives from any claims resultmg
from alleged acts of negligence on any of their parts.

It is THE USERS knowing intention to provide the CLAY FIRE DEPARTMENT
Inc. and any authorized representatives the broadest protection against lawsuits that are
available.

THE USER has read the above information, agrees to it, and has had an
opportunity to ask any questions that THE USER may have.

I (print) B - , - ,
Signing on behalf of (print) _ L . certify
that Y am authorized to agree to the terms and conditions of this agreeément on my behalf,
of the organization and the organization’s members. FOR THE TRAINING YEAR -
JANUARY 1, 2021 to DECEMBER 31, 2021

Signed .

Title

Date

Clay Fire Department, Inc. Representative
print Chie

Signed _

Date




To the TOWER COMMITTEE of CLAY FIRE TRAINING TOWER

The firefighters, or personnel listed below are active members of the
Fire Department(s) are
authorized to partake in the training to be conducted at the Clay Training Tower on (date)

The training to be conducted may contain evolutions that simulate and/ or create
actual firefighting conditions, rescue situations, fire fighter survival situations and
other emergency situations.

By signing below the firefighters, or personnel and fire department representatives
affirm that those listed below have medical clearance to perform the functions to be
trained on. The firefighters are authorized to use SCBA and participate in these
activities.

PRINT NAME ‘ PRINT NAME

Officer In Charge of Visiting Department
NAME Signature




North Syracuse Fire Department

Memo

To: Mayor Butterfield
Dianne Kufel, Village Clerk

From: John Linnertz
Deputy Chief;

Date: May 4, 2022
Re: Annual Hold Harmless Agreement — Clay Fire Training Tower

Attached is the Annual Hold Harmless Agreement for the Clay Fire Training Tower, Would
you please review and sign?

Thanks







Dianne Kufel

From: Franco, Amy <AFranco@chacompanies.com>

Sent. Thursday, May 19, 2022 2:00 PM

To: Gary Butterfield; Dianne Kufel

Subject: [External] FW: [--EXTERNAL--]: 2022 AARP Community Challenge Application Decision

, didn’t receive.

Amy Frafco; REA

Landscape Architect IV

CHA

Office: (315) 257-7236
Mobile: (315) 440-0585
afranco@chacompanies.com
www.chacompanies.com
*NY

CEIL-EBRATING

C

Responsibly Improving the World We Live In

i Lglin]

1952.2022

From: Community Challenge <CommunityChallenge @aarp.org>

Sent: Thursday, May 19, 2022 10:21 AM

To: Community Challenge <CommunityChallenge@aarp.org>

Subject: [--EXTERNAL--]: 2022 AARP Community Challenge Application Decision

Thank you for your recent application to the 2022 AARP Community Challenge grant program. We received over
3,200 applications from communities nationwide. As such, the decision-making process was a difficult one, with
many worthwhile organizations with inspiring projects vying for a limited amount of grant dollars,

Unfortunately, your organization was not selected for funding at this time, We value the work you do and, in some
cases, the AARP National Livable Communities Team or the AARP State Office in your state may be in touch with you
as a follow-up to discuss your work more. Due to the incredibly high number of applications, we are not able to
provide individual feedback to applicants.

We are committed to supporting communities and those leading the way for change. In addition to the Community
Challenge, we also collect and share innovative ideas and analyze insights with leaders nationwide through our
website (AARP.org/livable) and our free e-newsletter (AARP.org/livable-subscribe).

Again, thank you for your application to the AARP Community Challenge. We look forward to finding future
opportunities to work with you in making communities across the nation great places for people of all ages.
1







Sincerely,

The Community Challenge Team

online aarp.org/CommunityChallenge

facebook @AARPLIvableCommunities | twitter @AARPLivable
email CommunityChallenge@aarp.org

1AARP

COMMUNITY
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Grants to make communities livable for people of all ages
aarp. org/CommumtyChalIenge

AARP Community Challenge 2022

Grants to make communities more livable for people of all ages

;“'mntted through the online application portal at -
,_H\‘challen"" & by March 22, 2022, 5:00 p.m. ET

AII apphcat":' ns mus“

NOTE: All fields must be filled out completely in order for the application to be
accepted. Please use “n/a” for “not applicable” where appropriate.

BASIC INFORMATION

1. Name of Applicant Organization: Village of North Syracuse

2. Amount of this grant request: $17,615

NOTE: AARP reserves the right to award less funds than requested, so applicants should be prepared to discuss how
they would scale down their proposals if asked.

3. Organization Profile. How has this organization been involved in work to make this community more
livable, particularly for people 50-plus? Please briefly describe and include the issues on which the
organization has worked. The Village of North Syracuse, via the Board of Trustees, Beautification Committee. Health and

Safety Committee, and Senior Citizen groups, serves its constituents and is always looking for ways to better interconnect
the Village residents, businesses, and services. The Village's capital projects always include improvements to promote

4. Organization Mailing Address: non-vehicular travel and safety for people 50-plus.

Address: 600 South Bay Road
city: North Syracuse State: NY Zip:13212

5. Organization Tax Status. Please check the one that best applies:

501(C)(3) Nonprofit
501(C)(4) Nonprofit
501(C)(6) Nonprofit
a municipality

another unit of government

Uxgono

other (Please Describe)

Learn more at AARP.org/CommunityChallenge Questions? Email CommunityChallenge@AARP.org
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6. Organization Tax Identification Number: n/a

(if municipality, enter n/a)

7. Organization Website: https://northsyracuseny.org/

(if none, enter n/a)

8. Organization Twitter Handle: n/a
(if none, enter n/a)

9. Organization Facebook Name: https://www.facebook.com/nsyrvillage 1925 / @nsyrvillage1925
(if none, enter n/a)

10.Did your organization apply for an AARP Community Challenge grant in 2017, 2018, 2019, 2020, or 2021?

[] Yes —Selected more than once
[ ] Yes—Selected once

Yes — Not selected

[ ] No —did not apply

11.How did you hear about this grant opportunity?

The AARP State Office in my state

The AARP Livable Communities e-newsletter
An organizational newsletter or conference
A local event or newsletter

Word of mouth in the community

Social Media |

Other:

OO0 OoUk U

POINT OF CONTACT

12. Organization Contact:
Name: Gary Butterfield Title: __Mayor

Phone: 315-458-0900 Email: gbutterfield@northsyracuseny.org

COMMUNITY DETAILS -

13. Name of municipality where project will be physically located/delivered:
Village of North Syracuse

14. Approximate address where this project will be delivered:
NOTE: This information is for AARP’s analysis purposes only and will not be used in award information, etc.

Address: South Bay Road at Maxwell Avenue and Grove Street

city: North Syracuse state: __ NY zip: 13212

Learn more at AARP,ora/CommunityGhallende Questions? Email CommunityChallenge@AARE.orq

N



HER. AARP Community Challenge 2022

15. Approximate population for the city/town/area where this project will be delivered:
NOTE: Please only enter a numerical amount and not population ranges. We recommend a quick internet search of
the municipality and population.

Village of North Syracuse Population: 6,800

16. Would you describe this community as:

[ Rural
X' suburban
[] Urban

PROJECT DETAILS

17. Project Description. Please provide a description of your project in 2,000 characters or less (including
spaces). Please also include any benefits of your project specifically for people 50-plus.

The Village is proposing to install a crosswalk along South L
Bay Road within the residential area of Maxwell Avenue NOTE: This grant. may NOT be
and Grove Street. Currently, along this approximately 2 ~used for the following activities:
mile stretch of roadway that bisects the Village from north ’ '
to south, there is only one (1) intersection with crosswalks.
The Village Board has identified this location as an ideal

. Partisan,/ political or election
- related activities

location to install an additional crosswalk to connect the * Planning activities,
residential neighborhoods with the nearby businesses and assessments or surveys of
services. This area of the Village also has the Village .- communities without tangible
public pool, which is heavily used throughout the summer. engagement

: * Studies with no follow-up
The project would include two (2) solar powered crosswalk action
Rectanqular Rapid Flash Beacon (RRFB) signs that have
push button notifications and flashing LED light-up

» Publication of books or

technology to alert drivers that someone is crossing. . reports :
Additional signage would be installed prior to the * The acquisition of land and/or
crosswalk rllotinq the upcoming crogswalk. A new concrete buildings or a vehicle (such as
gldewalk with ADA detectable warning surfapes would be a car or truck) purchase
installed on both sides of the street along with new ‘ : .

crosswalk striping across South Bay Road. The Village * Solely to sponsor other

has installed this same system along its Main Street, organizations” events or
which has been successful. activities

~» Research and development
for-a nonprofit endeavor

, ~;TRésearch'and development
- for a for-profit endeavor

* The prombtion of a for-profit
entity and/or its products and
services

Learn more at AARP ovg/CommunityGhallenge Questions? Email ConununityChallenoe@AARP.ora
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18. Project Short Summary. In under 250 characters (including spaces), please describe your project and the
impact it will have on the community. Please include relevant references to older adults. Think of it as a

one or two sentence summary you would include in a press release.
For example; This project will turn overgrown vacant lots'inte community gardens with raised

flower beds and install acc‘ess’ib\/éf'bé'nbhés-:dt a park fr'edt{efrttédﬁby older adults.

The South Bay Crosswalk Installation Project will provide safe pedestrian access for all and create
connectivity within the Village with signage, striping, ADA access, and sidewalk improvements.

3

Social Impact Goal. Which of the following social impact goals best describes your project?

20.

L] increasing social connections between older adults and all residents of the community (with a focus
on people age 50 and older)

improving the health and wellness of older adults and all residents of the community (with a focus on
people age 50 and older)

Improving economic conditions for older adults and all residents (with a focus on people age 50 and
older)

increasing ways older adults and all residents (with a focus on people age 50 and older) safely move
around the community

creating a range of housing options for older adults and all residents (with a focus on people age 50
and older) to safely live '

strengthening connections between government, older adults and all residents (with a focus on
people age 50 and older), leading to improved community relations

making the community more inclusive and meeting the needs of diverse older adults and residents
(with a focus on people age 50 and older)

O 0O Kk O 0O

21. Project Category. Please select the category below that best describes your project, along with the

primary corresponding subcategory.
NOTE: We understand there is some crossover between categories and that several might apply to your

project. Please select the main category that aligns most closely with your initial goal.

L] create vibrant public places in the community through permanent or temporary solutions that
improve open spaces, parks and access to other amenities for residents {especially those 50-plus)

[ Activities to engage residents (particularly people 50-plus) in vibrant public places (e.g., open
streets events)

[J Public space activation with a focus on the needs of those 50-plus (e.g., public plaza
improvements, parklets, street trees, alleyway activation, accessible seating and games in
public spaces, seating along Main Street corridors, signage in neighborhoods)

[ Public art installations that make a space more inviting for multigenerational use, including to
decrease 50-plus social isolation (e.g., murals and sculptures that are connected to a broader
plan for multigenerational use for the public space)

Learn more at Mmmmmwm@ Questions? Emails}wmwmﬁmmwmmm&&&m
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Park enhancements to serve all residents with emphasis on people 50-plus (e.g., accessible park
equipment improvements, new structures, dog parks)

Community gardens for all residents (especially for people 50-plus) (e.g., building accessible
community garden beds) ’
Accessibility of amenities (e.g., increasing accessibility features of park equipment)

Public safety interventions (e.g., proper lighting, landscaping, block revitalization/maintenance)
Other (please only select if your project does not fit into one of the above categories and please
describe in detail)

Deliver a range of transportation and mobility options for residents (especially those 50-plus)
through permanent or temporary solutions that increase connectivity, walkability, bikeability and
access to public and private transit and safety.

J

a

Activities to engage people (with an-emphasis on people 50-plus) in transportation
options/safety (e.g., open streets events)

Roadway/sidewalks/crosswalk improvement and beautification (with emphasis on the safety
needs of the 50-plus) (e.g., markings for crosswalks, traffic calming pop-ups at intersections)
Bikeability, especially for people 50-plus (e.g., bike sharing options, temporary bike lanes)
Public or private transit access and safety for residents (with an emphasis on people 50-plus)
(e.g., transit shelters, activating and improving transit stops)

Micro-mobility enhancements/management for residents (with an emphasis on people 50-plus)
(e.g., parking and training on scooters, e-bikes for older adults, etc.) _

Expansion and enhancement of existing transportation options (especially for people 50-plus)
(e.g., adding volunteer-led transportation programs, enhanced coordination of existing
transportation resources)

Improved wayfinding throughout the community (e.g., signage and markings that are visible for
all ages)

Trails (e.g., completing and connecting trails, signage, improving accessibility for all abilities and
people 50-plus)

Accessibility of transportation amenities (e.g., increasing accessibility features of transportation
options for people of all abilities, including ADA compliance, with emphasis on people 50-plus,
etc.)

Other (please only select if your project does not fit into one of the above categories and please
describe in detail)

] Support a range of housing options for residents (especially people 50-plus and their families) in the
community through permanent or temporary solutions that increase the availability of accessible and

affordable choices,

]
O

Accessory dwelling units and tiny homes, particularly those with accessibility features
Co-housing programming and resources for older adults

Leamn more at AARE.ara/CommunitvGhallenge Questions? Email CommunityChallenae@AARP ord
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[] Resources about housing options and available services for residents (with emphasis on those
50-plus)

[ Innovative or new home maintenance, repair and support services to support residents’ ability

to live independently and age

Lifelong housing and accessibility for older adults

Other (please only select if your project does not fit into one of the above categories and please

og

describe in detail)

] Increase civic engagement with innovative and tangible projects that bring residents (especially
those 50-plus) and local leaders together to address challenges and facilitate a greater sense of

inclusion.
[J Developing projects based on residents’ (especially people 50-plus) priorities (e.g., participatory

budgeting efforts)

[ Bringing resident insight and volunteer power (especially people 50-plus) into local government
(e.g., citizen academies, local volunteers supporting City Hall efforts)

(0] Engaging residents alongside thought leaders in problem solving for wants and needs,
especially those 50-plus (e.g., hackathons)

[ Tools and programming to capture data and feedback from residents {especially those 50-plus)

[] Activities that highlight the use of data to improve decision-making in local government,
especially on behalf of older adults

(J Other ideas that improve civic éngagement in the community (please only select if your project
does not fit into one of the above categories and please describe in detéil)

] Focus on diversity, equity and inclusion while improving the built and social environment of a
community for all ages (focusing on residents age 50 and over).
[ Inclusive housing solutions that address disparities, with a focus on people 50-plus and meet

the needs of diverse populations

[7 Inclusive transportation solutions that address disparities, with a focus on people 50-plus and
meet the needs of diverse populations

[J Inclusive public space improvements that address disparities with a focus on people 50-plus
and meet the needs of diverse populations '

[ Inclusive civic engagement efforts that address disparities with a focus on people 50-plus and
meet the needs of diverse populations

[ Inclusive efforts to help family caregivers and allow residents with a focus on people 50-plus to
live independently as they age

[ Other changes to make a community more inclusive, address disparities and meet the needs of
diverse populations (please only select if your project does not fit into one of the above
categories and please describe in detail). ’

Learn more at AARP.org/CommunityGhallende Questions? Email CommunityGChallenge@AARE.0q
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L] Support communities’ efforts to build engagement and leverage funding available under
new federal programs to support residents (especially those 50-plus) through laws like the
American Rescue Plan Act, the Infrastructure Investment and Jobs Act, and more.

O

t

Activities to engage residents and build support for planned investments or installing temporary
or permanent changes that build on changes under new federal programs that improve a
community’s transportation infrastructure, with a focus on people 50-plus (e.g.,
demonstrations of roadway, crosswalk, sidewalk improvements, improving the accessibility of
public transit, etc.) '

Activities to engage residents-and build support for planned investments or installing temporary
or permanent changes that build on changes under new federal programs that improve a
community’s housing options, with a focus on people 50-plus (e.g., programs and outreach to
increase housing stability, demonstrations of new housing options, additional improvements to
existing or planned housing, etc.) ;

Activities to engage residents and build support for planned investments or installing temporary
or permanent changes that build on changes under new federal programs that improve a
community’s public spaces, with a focus on people 50-plus (e.g., demonstrations of new park
accessibility and public space improvements, improving spaces that were improved leveraging
federal funds, etc.)

Activities to engage residernits and build support for planned investments or installing temporary
or permanent changes that build on changes under new federal programs that improve a
community’s connectivity to broadband/high speed internet, with a focus on people 50-plus
(e.g., purchasing of hotspots, expanding wireless network access at libraries, training/engaging
older adults, etc.) '

Other (please only select if your project does not fit into one of the above categories and please
describe in detail) ‘

L] other Community improvements; including health services, community development, and
coronavirus pandemic recovery (with a focus on the needs of people 50-plus)

Cl

Recovery from the coronavirus pandemic with an emphasis on community development,
improvements to public spaces and transportation services, with a focus on people age 50 and
older

Connectivity improvements, including broadband access, with a focus on people age 50 and
older

Activities that increase access to healthcare services, with a focus on people age 50 and older
Activities that support family caregivers, with a focus on people age 50 and older

Activities to support entrepreneurship to improve economic resilience for people age 50 and
older.

Other (please only select if your project does not fit into one of the above categories and please
describe in detail)

Learn more at AARP.ora/GommunityGhallenge Questions? Email ComiunityGhallenge@AAREP.oru
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Project Deliverables. Please specify the individual deliverables of your project. Quantify and provide as
much detail as you can about any physical structures {such as benches, lighting, signage, etc.), events,
dates, addresses, communications, people reached, volunteers involved, etc. within 300 characters
(including spaces) for each deliverable.

Before you enter your answers, PLEASE READ the examples below and review Attachment D.

For examp/e

I. The Organlzat/on wr/l purchase and /nstall structures with LED hghtmg with custom srde panels at (ADDRESS)
a Quantlty L
i, The Organ/zat/on will purchase an /nstall ADA comphant benches at (ADDRESS)
a Quantity A :
il. The Orgamzatlon wr/l purchase and rstall AARP branded signage at (ADDRESS)
o. Quantity:15 ‘
V. The Organlzauon wrll purchase and mstall accessible raised garden beds
Quantity: 10 o : ,
V. The Organ/zat/an wrll holdc f e'n't'an; (DATE) (event examples: war’kshops, hackathon, trainings)
Quantlty GL ~
vl The Organ/zatlon s goa/ is t, ha ammunlty members to be trained at workshops on 50+ issues
. Quant/ty 250, Includmg;atvleast 125 people age 50 and older o
Vil. The Orgamzatlon WI// hold a (krck-off, rlbbon cutt:ng, etc,) event on November 1, 2022
. Quant/ty I S
Vill.  The Organ/zatlan has a goa/ of attendees at event
a. Quant/ty 400 tncludlng at least 200 peop/e age 50 and older
IX. The Organization will engage voluniteers over the course of the project — including painting accessible
benches made of outdoor materials, installation, and the kick-off event
a. - Quantity: goal of 70, including at least 35 peaple age 50 and older

Deliverable 1: The Village will purchase and install solar powered LED pedestrian crosswalk signs.

Quantity: __ 2
Deliverable 2: The Village will purchase and install pedestrian crosswalk signs.

Quantity: __ 2
3 The Village will purchase and install concrete sidewalk.

Deliverable

Quantity: _ 450 SF

Deliverable 4; The Village will purchase and install ADA detectable warning.

Quantity: __ 2

Deliverable 5: The Village will purchase and install crosswalk striping.

Quantity: __ 150 LF
Deli ble 6: The Village will communicate to the community by listing the project on the Board agenda, placing an
eliverable b: -\ suncement at Village Hall & the Iocal newspaper, & posting on the Village's website & Facebook page

Quantlty. ,

Learn more at AARP.ora/CommunityChallenge Questions? Email GommunityGhallenge@AARE.QLI
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23, Project Type:

NOTE: Proposals for the project types described below will be prioritized over those that support ongoing
programming or events.

D—(_] Permanent physical improvements in the community

] Temporary demonstrations that lead to long-term change

U] New, innovative programming or services

PROJECT NARRATIVE AND BUDGET

Please complete each section with 2,000 characters or fewer (including spaces).

24. Livable Communities Activities. Please describe how the Community Challenge project will be integrated

For over 20 yvears, Village officials have succeeded to make the Village of North Syracuse a more pleasant and safer place
for its residents, businesses and visitors. Utilizing the appropriate planning tools, the Village has been steadily preparing and
focusing on implementing projects that serve the community's best interests. The planning documents, committees and public
outreach provided a strategic opportunity to provide input and quidance for these projects; It is with this dedication that the
Village created a Village Center Master Plan and Village Center Streetscape Plan, as well as the Parks Master Plan that identify
the connections between the Village parks. Community meetings for these Plans provided opportunities for the public to provide
input and guidance.

Most recently, the Village was awarded a NYS Transportation Alternatives Program (TAP) Grant through the NYS
Department of Transportation (NYSDOT) to complete a Complete Streets East-West Corridor through the Village. The Village
was awarded this grant after working with the Central New York Regional Planning and Development Board (CNYRPDB) to
complete the “Village of North Syracuse Complete Streets and Re-Greening Plan”.in 2016. This study involved a focus group of
Village residents, business owners, and stakeholders. Being that the Village is a mixed demographic of ages and incomes
having strategically located crosswalks for pedestrian and bicycle travel for all to access and promote outdoor activities and
exercise creates a unified community.

25. Community engagement. Please describe how residents and local organizations have been engaged in
the.area’s livable communities' activities (with a focus on people 50-plus) to date. How will you engage

the.community and involve older residents as you execute this grant?

The Village has been steadily moving forward with its goal of becoming a thriving economic and residential core by providing
for safe and effective pedestrian, bicycle, and vehicular modes of travel, all while including the community in its decisions.,
When the Walkable Village Plan was initially done, the Village reached out to residents to obtain public comment and input.
More recently, the Village Center Master Plan, the Village Center Streetscape Master Plan, the SMTC “Church Street Access
Study,” the CNYRPDB "The Village of North Syracuse Complete Streets and Re-Greening Plan," and , finally, the SMTC
"Bicycle:Commuter Corridor Study." the Village has created committees, held public meetings, provided outreach. involved
the public and created stakeholders with each study that was completed. These studies have laid the necessary foundation
and informed the public in order to successfully accomplish the numerous projects that have already been constructed as a
result and those that are yet to come. The Village has been awaiting a grant opportunity in order to increase its non-vehicular
connectivity, Besides all of the numerous volunteers and organizations involved in the Village, the Village Board will notify
the public of its progress at its Board meetings and include progress on its website and Facebook page.

26. Role of volunteers. Will volunteers age 50 and older play a role in the implementation of the Community
Challenge project?

X] ves
D No

a. Please describe. NOTE: Even if you answered “No” above, if volunteers of any age will play a role in

implementing the Community Challenge project, please explain.

The Village has an active volunteer community with its North Syracuse Senior Group, Beautification Committee,
and Meals on Wheels. The volunteers will be involved with project outreach to the community and project
implementation. Volunteers communicating the new aspects of the crosswalk will increase the project's value
and use for the community.

Learn more at AAKKE.Qrg/ComunityGnalenge Guestions’s kmall LommunityLNalengeast,.org
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27. Older Adults. How will your project benefit residents age 50 and over?

The installation of a crosswalk with flashing yellow lights (RRFB) gives both pedestrians and drivers the ability to see
that there is someone crossing the street. By having a tactile interaction with the signage to activate the flashing
lights, it provides advance warning for drivers and for the pedestrian to take pause before beginning to cross. Studies
have shown that RRFBs increase motorist yielding rates, in one experiment from a baseline of 28% to an average of
93%, according to a BikeWalk NC article (2015).

28. Diversity and Inclusion. Regardless of your project category, will your project focus on, impact or benefit
a specific multicultural population of older adults and their families in the community?

D Yes
No

a. If so, please select the one or two who will be primarily impacted below.

African American/Black
Hispanic/Latino

Asian American Pacific Islander
Native American

LGBTQ+

Other:

Ooodaon

b. Please describe how the effort focuses on or impacts this population (including any emphasis on

people 50-plus and their families).

29. Disparities. Will your project improve or address existing disparities (including racial or economic}
experienced in the community {especially for people age 50 and older)?

@ Yes

D No The project will provide for a safe pedestrian crossing in an area that does not have any non-
vehicular connections. This area is designated low-income per the Community Development Block
Please describe: Grant program administered by HUD.

30. Veterans and Military Families. Will your project have an emphasis on veterans and their families of all

ages (including those age 50 and older)?

L] ves
X] No

Please describe:

Learn more at AARP,org/GommunityChallenge Questions? Email CommunityGhallenas@AARE.0rd
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31. Federal Investments. Regardless of your project category, is your project connected to any efforts that
were supported or are planning to build.engagement, under recent federal legislation that supports
communities (including the American Rescue Plan Act, the Infrastructure Investment and Jobs Act or
others) to benefit residents (with a focus on people 50-plus)?

X] ves '
] The Village has received monies from the American Rescue Plan Act of 2021 (ARPA), which
No provides municipalities with the opportunity to make necessary investments and improvements to
their infrastructure. As such, the Village will utilize ARPA funds to install any portion of this project
Please describe: that the grant does not cover.

32. Grant Budget. Please specify all expenses that will be covered by this grant. ltemize anticipated expenses
and income (if any) for this proposal. Please ensure that the Total Grant Amount Requested below
matches the amount you entered in Question #2 at the beginning of this application.

‘Expense | Additional infofmation
Contracted services costs $4,065 Engineering & Legal
Staff costs, if'any
(NOTE: AARP will typically-only award
grants that spend 0-15% on staff costs. /
However, AARP reserves the right to nia
award compelling projects that go
beyond this range.)
Materials & supplies, if any $13,550 ‘ Purchases by DPW
Travel expenses, if any n/a

33. Matching/Supporting Funds and In-Kind Support. Matching funds are NOT required. Please detail any
matching/supporting funds or in-kind support the organization will receive to contribute toward this
project. Include volunteer/donated work as in-kind support.

| Matchin"g"Fvun‘ds/“Suppqr:tingﬁ'Fuhdys’; P lh-Kfnd Support
Nonprofit
Private
Public ARPA, as needed Village personnel
Learn more at AARP.ova/CommunifyChallende Questions? Email GCommunityGhallenge@AARP org
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34. How will you use AARP branding?

35.

The Village will use the AARP logo and a statement that this project was funded by monies from AARP on the
project sign, the Village's website and Facebook page, and an announcement in the local newspaper.

Other Funding. AARP might be contacted by other potential funders that could be interested in funding
projects that were not funded through the AARP Community Challenge. The potential funders may have
additional process steps and funding requirements than those of the AARP Community Challenge. If
requested, AARP would like to send your contact information, organization name and a short description
of your proposal, including the community where the project would take place (“Project Information”).
Please note that these projects will be subject to any potential funder’s own terms, conditions and
review. Please indicate in your application whether or not you give permission to AARP to share your
Project Information with other potential funders. If you select “yes,” you agree on behalf of yourself and
your organization to release AARP and its affiliates and their respective officers, directors, employees,
contractors, agents and representatives from all liability associated with sharing the Project Information
with potential funders. We will alert you before this Project Information is given to potential funders. Do
you give AARP permission to share this Project Information with other organizations that might be

interested in funding your project?
YES
(] no

An opportunity for other possible AARP funding. Please note that by submitting a proposal for the AARP
Community Challenge initiative, you and your organization give AARP permission to reach out to you and
others at your organization about other possible AARP funding opportunities that your proposal may be
eligible for based on the AARP Community Challenge criteria. However, please note that AARP is not
obligated in any way to consider your proposal for any additional AARP funding.

NOTIFICATION

When you SUBMIT this application, you will receive a confirmation email within the
hour. Please make sure to check your spam folder if you do not see it. If you do NOT
receive a submission confirmation, you have NOT submitted successfully. Please go back
and make sure you completed ALL required questions and did not go over the text box

character limits.

All applicants will be notified of their funding status by email in May. To receive funding, selected
applicants must execute and return a binding Memorandum of Understanding and completed financial

forms to the AARP National office in a timely manner.

Learn more at AARP,org/ComimunityGhallenae Questions? Email GommunityGhallenae@AARE.org
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2022 AARP Community Challenge Grant
Village of North Syracuse
Crosswalk Installation Project

Cost Estimate

ITEM QTY UNIT UNIT COST TOTAL
Solar Crosswalk Signs 2 EA $3,000 $6,000
Pedestrian Crossing Signs 2 EA $350 $700
Concrete Sidewalk 450 SF $12 $5,400
Detectable Warnin 2 EA $350 $700
Crosswalk Striping : ' 150 LF $5 $750
Subtotal $13,550

Contingency (10%) $1,355
Engineering & Legal (20%) $2,710

Preliminary Cost Estimate|  $17,615




Meeting minutes




Short Environmental Assessment Form
Part 1 - Project Information

Instructions for Completing

Part 1 - Project Information. The applicant or project sponsor is responsible for the completion of Part 1. Responses become part of the
application for approval or funding, are subject to public review, and may be subject to further verification. Complete Part | based on
information currently available. If additional research or investigation would be needed to fully respond to any item, please answer as
thoroughly as possible based on current information.

Complete all items in Part 1. You may also provide any additional information which you believe will be needed by or useful to the
lead agency; attach additional pages as necessary to supplement any item.

Part 1 — Project and Sponsor Information

Name of Action or Project:

South Bay Road Crosswalk Installation Project

Project Location (describe, and attach a location map):

South Bay Rd at the intersection of Maxwell Avenue, Van Mara Drive, and Grove Street '

Brief Description of Proposed Action:

This project includes installing a crosswalk across South Bay Road within the residential area of Maxwell Avenue, Van Mara Drive, and Grove Street.
Along the approximately 2 mile stretch of S. Bay Rd. that bisects the Village from north to south, there is currently only one (1) crosswalk at the
intersection of Church Street and Centerville Place. The project would include two (2) solar powered crosswalk signs that have push button
notifications and flashing LED light-up technology to alert drivers that someone is crossing. Additional signage would be installed prior to the crosswalk
noting the upcoming crosswalk. A new concrete sidewalk with ADA detectable warning surfaces would be installed on both sides of the street along
with new crosswalk striping across South Bay Road.

¢ icant : ‘ . :
Name of Applicant or Sponsor . Telephone: 315.458-G900
Village of North Syracuse c/o Mayor Gary Butterfield E-Mail: gbutterfield@northsyracuse
Address:
600 S. Bay Road .
City/PO: State: Zip Code:
North Syracuse NY 13212
1. Does the proposed action only involve the legislative adoption of a plan, local law, ordinance, NO YES
administrative rule, or regulation?
If Yes, attach a narrative description of the intent of the proposed action and the environmental resources that D
may be affected in the municipality and proceed to Part 2. If no, continue to question 2.
2. Does the proposed action require a permit, approval or funding from any other government Agency? NO YES
If Yes, list agency(s) name and permit or approval: '
v] | [
3. a. Total acreage of the site of the proposed action? 0.6+/- acres
b. Total acreage to be physically disturbed? 0.6+/- acres
c. Total acreage (project site and any contiguous properties) owned
or controlled by the applicant or project sponsor? 0.6+/- acres

4, Check all land uses that occur on, are adjoining or near the proposed action:
5. [JUrban [C] Rural (non-agriculture) [ Industrial [] Commercial [] Residential (suburban)

[ Forest [] Agriculture [] Aquatic [] Other(Specify):
1 parkland

Page | of' 3




5. Is the proposed action,

<
23}
w

4 A permitted use under the zoning regulations?

b.  Consistent with the adopted comprehensive plan?

LIICT] 8

H|[NE

6. Is the proposed action consistent with the predominant character of the existing built or natural landscape?

=<
175

E

[X]

7. Is the site of the proposed action located in, or does it adjoin, a state listed Critical Environmental Area?

If Yes, identify:

~<
trl
7

[]

8. a. Will the proposed action result in a substantial increase in traffic above present levels?
b.  Are public transportation services available at or near the site of the proposed action?

¢.  Are any pedestrian accommodations or bicycle routes available on or near the site of the proposed
action?

=
=
17

NN

9. Does the proposed action meet or exceed the state energy code requirements?

If the proposed action will exceed requirements, describe design features and technologies:

SN RN EHNIEIEIEINIR

<
o
7]

10. Will the proposed action connect to an existing public/private water supply? NO | YES
If No, describe method for providing potable water:
Due to the type of project, there are no alterations to the water supply system. D
11. Will the proposed action connect to existing wastewater utilities? NO | YES
If No, describe method for providing wastewater treatment:
Due to the type of project, there are no alterations to the wastewater system. [::l
12. a. Does the project site contain, or is it substantially contiguous to, a building, archaeological site, or district NO | YES

which is listed on the National or State Register of Historic Places, or that has been determined by the
Commissioner of the NYS Office of Parks, Recreation and Historic Preservation to be eligible for listing on the
State Register of Historic Places?

b. Is the project site, or any portion of it, located in or adjacent to an area designated as sensitive for
archaeological sites on the NY State Historic Preservation Office (SHPO) archaeological site inventory?

13. a. Does any portion of the site of the proposed action, or lands adjoining the proposed action, contain
wetlands or other waterbodies regulated by a federal, state or local agency?

b. Would the proposed action physically alter, or encroach into, any existing wetland or waterbody?

If Yes, identify the wetland or waterbody and extent of alterations in square feet or acres:

YES

Hin




14. Identify the typical habitat types that occur on, or are likely to be found on the project site. Check all that apply:
[Ishoreline [] Forest [] Agricultural/grasslands [] Early mid-successional
[JWetland [] Urban [] Suburban

~

15. Does the site of the proposed action contain any species of animal, or associated habitats, listed by the State or ES

Federal government as threatened or endangered?
Least Bittern ‘

[X]

~<
7

E

16. Is the project site located in the 100-year flood plan?

[]

w
w2

E

17. Will the proposed action create storm water discharge, either from point or non-point sources?
If Yes,

a.  Will storm water discharges flow to adjacent properties?

HISIREBINIEIIE
NN

b. Will storm water discharges be directed to established conveyance systems (runoff and storm drains)?

If Yes, briefly describe:

The existing drainage system will be utilized.

18. Does the proposed action include construction or other activities that would result in the impoundment of water NO | YES
or other liquids (e.g., retention pond, waste lagoon, dam)?
If Yes, explain the purpose and size of the impoundment: -
| [V L]

19. Has the site of the proposed action or an adjoining property been the location of an active or closed solid waste | NO | YES

management facility?

if Yes, describe: ‘ ]
vl []

20.Has the site of the proposed action or an adjoining property been the subject of remediation (ongoing or NO | YES

completed) for hazardous waste?

If Yes, describe:
[v]| ]

I CERTIFY THAT THE INFORMATION PROVIDED ABOVE IS TRUE AND ACCURATE TO THE BEST OF
MY KNOWLEDGE

App]icant/sponsor/name: Amy Franco, RLA on behalf of the Village of N. Syracuse ) Date: 3/8/22

Signature:_ .,:{,,..,,,, PR Title: Landscape Architect

PRINT FORM Page 3 ol




EAF Mapper Summary Report Tuesday, March 8, 2022 3:26 PM

Disclalmer: The EAF Mapper is a screening tool intended to assist
project sponsors and reviewing agencies in preparing an environmental
assessment form (EAF). Not all questions asked in the EAF are
answered by the EAF Mapper. Additional information on any EAF
questian can be obtained by consuiting the EAF Workbooks. Although
the EAF Mapper provides the most up-to-date digital data available to
DEC, you may also need to contact local or other data sources in order
.~ lo obtain data not provided by the Mapper. Digital data is not a

1.2 substitute for agency determinations.
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Part 1/Question 7 [Critical Environmental  No
Area]

Part 1/ Question 12a [National or State No
Register of Historic Places or State Eligible
Sites]

Part 1/Question 12b [Archeological Sites] No

Part 1/ Question 13a [Wetla(nds or Other No
Regulated Waterbodies]

Part 1/Question 15 [Threatened or Yes
Endangered Animal]
Part 1/ Question 15 [Threatened or Least Bittern

Endangered Animal - Name]
Part 1/Question 16 [100 Year Flood Plain] No

Part 1/ Question 20 [Remediation Site] No

Short Environmental Assessment Form - EAF Mapper Summary Report







BUDGET TRANSFERS CC: Dianne ]

BOARD APPROVAL NOT NECESSARY  CC:wirequisition [ ]
USE BETWEEN SAME OBJECT ACCOUNTS

From: (Account #):

TO: (Account #):

Amount; ‘Q\”

4\\

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account #): p’*/l?) Pee
To: (Account #): » A0 V‘&h\a")f/\ @\)'{fm

Amount: ~ 535

Reason: ﬁ O /@,&% Y\,Q.ﬁdﬁ“‘a\& ALY ‘O@(,\MVL(J‘@—

From To
Account # Account #
( ¢ C{l“:’) ) (4 ;Z?D )
Present Account Balance: $ [ 7174 o $ & 5@” 0.
Change: $ * bwgm% $ 52.‘57
New Account Balance: &5? ~

Signature of Department Head: 7/ C/% 57/ ‘‘‘‘‘

(To approve the Transfer) %
Date: / 1l




BUDGET TRANSFERS cC:Damme [

BOARD APPROVAL NOT NECESSARY  CC:wirequisition [ 7]
USE BETWEEN SAME OBJECT ACCOUNTS |

From: (Account #):

To: (Account #): \

Amount: | A\

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account #): , a1 ph\!,f»’\;cm\fa
To: (Account #): o A20 \fe/\(\\lo\s@/ ECP U*! bQM

& A
Amount: - ggp0 %

Reason: dO[ [ (),(‘.,,&” V\Qggﬁ‘\w Q@QO\N\T& \OC?@\M«Q/
From To
Account # Account #
( eds ) ) _ )
Present Account Balance: $ &Zﬂ(ooc} B lb&.ﬁm”?
Change: $ ~55DP $M

1 O ey e O
New Account Balance: $ 94{0 3¢ = 47357

Signature of Department Head: T
(To approve the Transfer)

Date:




- BUDGET TRANSFERS CC: Dianne ]

BOARD APPROVAL NOT NECESSARY  CC:w/requisiton [
USE BETWEEN SAME OBJECT ACCOUNTS

From: (Account #):

To: (Account #):

Amount: R\Y?\\’“\b%

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account#): _s46't  Ropru. g
To: (Account #): ¢ AB0 V‘QM(:&Q Ecgugigwu

6
Amount: * \"708%

Reason: (\{@\(/?,é_iﬁ” V\ngf%“\ué/ OCLOINY- \QCZX\&WCJ‘{'?

From To
Account # Account #

Codd ) C Y
o sy
Present Account Balance: $ RS ~ $= 2505

Change: $ = 1708 $_1708 &
. Py, .00
New Account Balance:  $___ 917 $ = (0887~

Signature of Department Head: ™

(To approve the Transfer) g
Date: f /0’/ LA




BUDGET TRANSFERS ccpame [

BOARD APPROVAL NOT NECESSARY  CC: wirequisiton [
USE BETWEEN SAME OBJECT ACCOUNTS

From: (Account #):

To: (Account #):

Amount: wz\\—b@}

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account #): HbYq Rﬁc;»fuﬁ:lﬁ%

To: (Account#): «d&  plwefs  coa™

Amount:~ gaqz®

Reason: (q O et V‘ogmﬁu@ (AM(?).)WQ‘ %,\a,no@
From To
Account # Account #
( ) ( ,3ad )
Present Account Balance: $ 4 lf2°9 $ ° daaz?
Change: $ = azaz % $ 3%3@"‘9
C_\

~o2
New Account Balance: $ ModdH

Signature of Department Head:

(To approve the Transfer)
Date: & /

(7




BUDGET TRANSFERS CC: Dianne I

BOARD APPROVAL NOT NECESSARY  CC: wirequisition [
~ USE BETWEEN SAME OBJECT ACCOUNTS

From: (Account #):

- To: (Account #): K\ \ﬁ‘)

Amount: %\A«/b

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account#): _e Hlsle Tﬁ%\m"\‘gw
To: (Account #): _LQEL chieks Cav™

3
Amount.” 2400

Reason: Cofreet r\;),(,’g(;@,iwe, AL LOMNT \Oﬁb\ﬂMCMQ_«

From , To
Account # Account #
(oo ) (,ax )
e 60
Present Account Balance: $ 351 BBQ’/ $ " LM%Z o
ot (o]
Change: $= Jzgo 7 s Jaoe =
; o
New Account Balance: $ [03309.’ SR Q2.
Signature of Department Head: "D /% ..
(To approve the Transfer) A7

Date: ‘)/l /0(2/7—-/‘




BUDGET TRANSFERS CC: Dianne ]

BOARD APPROVAL NOT NECESSARY  CC: wirequisition [ ]
USE BETWEEN SAME OBJECT ACCOUNTS ;

From: (Account #):

To: (Account #):

%K\\@\ e

Amount: Ay

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account #): L{(Q"Y Pt)b E‘&Q
To: (Account #): 2 AR Oﬂ\@,&-ﬁ CoV_

o’

B ,
Amount: = 3 pep

Reason: CC)(‘ { 9,()@ !-\%m&m‘ € ..Ctma)ﬂfk‘ b(}b\ﬁlmg

From ‘ To

Account # Account #

( 2 HbN ) ( AP~ )

0C
Present Account Balance: $ _%, qoo $ - ’7‘%‘?62 -

Change: $ = 3600 % g JodD

4] | e

New Account Balance: $ QOD - lfﬂg& ~

Signature of Department Head: T2/
(To approve the Transfer)




BUDGET TRANSFERS CC: Dianne
BOARD APPROVAL NOT NECESSARY  CC: wirequisition

USE BETWEEN SAME OBJECT ACCOUNTS

From: (Account #);

To: (Account #):

Amount: Sk A7
L=

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account#): » 475 Ec?w]'m Mant-
To: (Account#):  » A/ &Y;\@(zs Cev/™

Amount: Hse0 |
Reason: (of !tg,cﬁ fgﬁ@%\(}@ CX;C,(},(D.,)V\F}‘ m\«cﬁma’@/

From To
Account # Account #
( o™ ) ( o do- )
P Balance: $ 1.IR2% 13994 o
resent Account Balance: $ = I
Change: $ =650~ $ (SeoE-
4 8L,
New Account Balance: g 1dR3 ™ $”""7‘4Q3« ”

,,»-"“ - / -
Signature of Department Head: v’ ,
(To approve the Transfer) / 7
Date: S/ / M,L A

]
I




BUDGET TRANSFERS CC: Dianne

BOARD APPROVAL NOT NECESSARY  CC: wirequisition

USE BETWEEN SAME OBJECT ACCOUNTS

From: (Account #):

To: (Account #):

| 5
Amount: w v
A

Reason:

BUDGET ADJUSTMENTS

BOARD APPROVAL NECESSARY
USE BETWEEN DIFFERENT OBJECT ACCOUNTS

From: (Account#): _e “l{3 PPE
To: (Acéount #): M0 Paed

!

i
Amount: = 4641 %

Reason: Cofreak V\Q{Q)Cfll(”\k_;& C‘\JE(?QJ\/\IAV (DCA)\,&VLM

From To
Account # Account #
( JMHB ) ( .aL{D
Present Account Balance: $ H%ZZ@ $ - “\0"{(
Change: $ L{OC‘“M _ $ HOH\
New Account Balance: 1 '73’1

Signature of Department Head: ; /I/%L'
: (To approve the Transfer) /
Date: % S// ofel

]
]



Daniel Kirkpatrick

218 Fergerson Park

N. Syracuse, NY 13212
315-415-5691
kirkpatrick.dan@gmail.com
May 24, 2022

Village of N. Syracuse

Attn: Mayor and Village Tree Board
400 South Bay Rd.

N. Syracuse, NY 13212

DearMayor, and Village Tree Board,

Thisis notice of irreparable damage and liability of the large tree at street line at 218 Fergerson Park. I notified
previously by email on January 2, 2022. And again recently called DPW Superintendent on May 15, 2022. Ed -
Ware says it's my responsibility (quoting 219-12, but that refers to trees in private property overhanging right-
of-way or street), but this tree is on public property, not private property. I'm not getting anywhere with DPW

as it's not on private property.

Historically in the 28 years I have lived here, the village has taken responsibility of the trees at the street line,
including and not limited to: Village removal of tree on corner of 220 at same distance, removed trees at 222,
204 and 200, and trimmed damage/liability at 226. Also this tree had a limb or two trimmed by the village in
recent yeats.

Half of the tree has damage and impending rot, woodpecker damage, and is a liability.
On Dec 11,2021, a large limb (over 1' diameter and 25+ long) broke off, damaging neighbor's car, and I'm
worried about the rest of that half falling.

The tree is on village/public property, not private property, and according to my survey, I only own up to about
where the swing is attached (I also placed a measurement stake), about 10' away to tree base. Measuring from
the survey shows the road at least 10' smaller radius in real life, and the tree being *IN* the street. (My
property ends 56.5' from the stake in the middle (and 24.2' from front of house).

I have the base of the limb that came.down that shows evidence of weakness and rot, as well as several pictures
and survey included.

Please have the village take care of this liability so it does not fall on and damage my house, or harm the public.

219-10 Grants village to maintain and remove trees within the rights-of-way and public grounds.
219-12 refers to trees on public property, overhanging right-of-way or street, yet tree is not on private property.

This serves as notice that the tree is damaged and a liability, and on village/public property.
(I can provide higher quality pictures on request by email).

Sincerely,

<l

Daniel C. Kirkpatrick
218 Fergerson Park




a

\\.'\ Contrat NY v orycflang s - NY Stated

131,44

-~ YLMUERGF ~ -

o Preshnen AL { ond Survewers. i Ameri an Cengrons 0a Survng and Manong

s, /5

va

105

tar iz ]

750. 20"

bEEY \m\ sN&\\wQM
I lD MmAP PI76S (er~q03})

~“Map OF:

LOTS i5,16 AND PART OF 17
FERGERSON PARK TRACT

e sunvevee CARTINTS THAT THIS VILLAGE "OF NORTH SYRACUSE

wAP 15 MAGE FROM AN ACTUAL SURVEY OF THE PROPERTY OZQZQbe QQCZﬂK zms vsomm.A

orOw HEREON, ConpLeTEn. L2 2e= L C wSE . -,
7 RICHARD H. ZOGG e LE=20

. ~ LICENELD LAND SURVETCR care YOV, m@ (793
N BYRACUSE, M. 4E. _vm = o. 4130 WILLOW Z0AD
LICENSID LAN o
WOATR ¥ RORTH SYRACUAC, N. Y. 13212 _ - —\ _ 9574
















